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User Manual 
 

1. Introduction 

1.1 Purpose 

The purpose of this document is to describe the capabilities, functioning, use and 

installation of Icarus – High-Precision 3D Physics Simulator.  
 

1.2 Scope 

In this document, we discuss the meaning and use of a scenario in Icarus, which 

elements that it includes, how it is configured, how to start a simulation, how it is 

optimized, and how to visualize and edit it.  

 

It also presents the interface that allows the user edit and navigate the scenario 

easily.  

 

Some of the images used are taken from the Spanish version of this manual. 

 

1.3 Definitions, Acronyms, and Abbreviations. 

IPE – Icarus Physics Engine 

Scenario – the set of bodies, objects, scenery, simulation configuration, and video 

settings editable by the user. 

 

1.4 References 

Icarus Physics Engine – Manual – English.doc 

 

 

1.5 Website 

In Icarus’ website, you can freely download the latest version of its software: 

 

http://www.icarus-physics.com/ 

http://www.icarus-physics.com/
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2. ¿What is Icarus? 
 

Icarus is physics simulation engine that allows visualizing 3D phenomena related to 

gravity and electromagnetism applied to mass bodies or point charges. 

  

Icarus allows creating customized scenarios according the necessities of its users or 

loading previously created scenarios. 

 

In Icarus’ Scenarios, the user can add mass/charged bodies, and electric/magnetic 

fields and establish their interactions.  

 

Once the scenario is defined, the user can initiate the simulation and watch its 

course in real-time. It can also be paused and observed from different angles.  

 

2.1  ¿Who can use Icarus? 

 

Icarus can be used as educational software, focused to improve the learning of 

physics phenomena. The following user profiles can benefit from its use: 

 

 Students - Can easily visualize and configure in real-time and 3D the solution 

of physics exercises. 

 

 Teachers - Using a projector, or in a laboratory, can show students difficult to 

explain physical phenomena on board or on paper. 

 

 Researchers - Can model real high complexity systems and get analytical 

results of extreme accuracy. 

 

2.2 ¿What is a scenario? 

 

An Icarus Scenario represents the set of bodies, simulation configuration, and video 

settings set by the user. 

 

Everything that can be modified in Icarus is saved in the Scenario and therefore 

loaded in the future, recovering the entire scenario’s data. 

 

Each Scenario in Icarus has a particular name that distinguished it from others 

(there cannot be two scenarios with the same name), a description, and a 

classification. 
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The name and the description of the scenario can be changed by the user in any 

moment. The classification (from now on referred to as Scenario Type) defines the 

purpose of the scenario at the moment of its creation and cannot be changed later.  

 

There are 4 different types of scenario: 

- Gravitation 

- Electromagnetism 

- Galaxy Simulation 

- Customized 

 

Each scenario limits the type of bodies that will intervene in the simulation. This 

helps to a better understanding of the software, and a better classification of the 

scenarios created.  
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3. Installing Icarus 
 

In order to install Icarus in your computer, first download the last version from: 

 

http://icarus-physics.com/icarus/downloads.html 

 

Once downloaded, execute the file, and follow the installer’s steps. 

 

 

 
Figure 1 – Icarus’ Installer front page. 

 

 

3.1 System Requirements 

3.1.1 Minimum Requirements 

 

The list of minimum system requirements to run Icarus are shown below: 

 

 Operating System: Windows 2000/XP/Vista/7/8 

 RAM Memory: 256 Mb 

 Free space in hard disk: 50 Mb 

http://icarus-physics.com/icarus/downloads.html
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 CPU: 1.0+ Ghz* 

 GPU compatible with DirectX 9.0+ 

 

*The Multi-threading option will only improve the performance  if the 

processor has more than one core. 

3.1.2 Software Requirements 

 

The list of minimum software requirements to run Icarus are shown below: 

 

 It must be compatible with Direct3D and DirectDraw. 

 Microsoft .NET Framework 3.0 or later. 

 Visual C++ Redistributable Package  

(Icarus will install it if not present) 
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4. Acquainting with Icarus… 
 

The first window presented when executing Icarus is the welcome message: 

 

 

Figure 2 – Welcome Message (Spanish) 

 

The user can choose whether create a new scenario, load an existing scenario, or 

exit Icarus. Each one of these options is explained below. 

 

4.1 Load a Scenario 

 

Icarus allows the user loading an existing scenario, whether it is an example pre-

included in Icarus or one created by the user. 

This allows designing an scenario and load it later to use or simulate it, for example, 

during a lecture. 

There are two ways of loading an scenario: 

4.1.1 Load an scenario upon starting Icarus 

 

You can load an scenario by selection the option “Load an example scenario” 

from the Icarus’ welcome window (see Figure 1). 

 

 

4.1.2 Loading an scenario from the main window 

 

The user can load an scenario selecting the “File > Open Scenario...” (Figure 

3) option from the menu, or by clicking the load file icon (Figure 4).  
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Figure 3 – Open scenario from Menu 

 

Figure 4 – Open Scenario from Icon 

       

 

Once selected, a “Open Scenario” will open (Figure 5). In this window, the user 

should first choose the type of scenario (5-1) that he/she wishes to load. Upon 

selecting it, a list with the existing scenarios from that type will load and display.  

 

 

Figure 5 – Open Scenario Window 

 

The user can select now one of the scenarios from the list (5-2). After choosing a 

scenario, its description is displayed (5-3), along with a preview image (5-4). 

 

Once the scenario is selected, the user must click the “Open” button (5-5) to load 

the scenario. 
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4.2 Creating a new Scenario. 

 

Icarus allows creating a new scenario from the predesigned templates for each type 

of scenario. These templates have the initial configuration by default that are 

adequate for each type of scenarios, although the user can change them later.  

 

There are two ways of creating a new scenario: 

4.2.1 Create a new scenario from the Icarus welcome window. 

 

A new scenario can be created by selecting the option “Create New Scenario” 

from the Icarus’ welcome window. (Figure 2). 

 

4.2.2 Creating a new scenario from the main window 

 

The user can load an scenario selecting the “File > New Scenario...” (Figure 6) option 

from the menu, or by clicking the new file icon (Figure 7).  

 

 

Figure 6 – New Scenario From Menu 

 

 
Figure 6 – New Scenario from Icon 

 



Icarus   Version:           1.0 

User Manual   Date:  14/10/2010 

 

http://www.icarus-physics.com/ Universidad Nacional de La Matanza Page 12 de  70 

 

Once selected, a new scenario window will open (Figura 8). In this window, the user 

must first insert the name of the new scenario (8-1), and then choose the scenario 

type that will be used (8-2). A brief explanation of each scenario type will show in 

the text box below (8-3). Once all the options are defined, the user must click on OK 

to create the new (8-5). 

 

Figure 7 – New Scenario Window 
 

Optionally, the user can accede to the scenarios’ advanced configuration (8-4). In 

this window (Figure 9), the user can pre-configure the magnitudes (9-1) and the 

time differential to use (9-2). More information about these variables can be found 

later in this manual. 

 

 

Figure 9 – Advanced configuration Window 
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4.3 Save Scenario 

 

Icarus allows saving the current scenario to be loaded later. By saving, all the 

scenario’s bodies, and settings are saved. Therefore, while loading a saved scenario, 

the user recovers the exact state in which the scenario was saved. 

 

A scenario can be saved by selecting the menu option “File > Save Scenario” (Figure 

10) or clicking over the Save Scenario Icon (Figure 11). 

 

 

Figure 8 – Saving a Scenario from the Menu 

 

Figure 9 – Saving an Scenario from the 

Icon 

 

4.4 Changing the Scenario’s Name and Description 

 

In order to change the Scenario’s name and description after creating it, you can 

accede the “Scenario Properties” window from the main menu (Figura 12): 
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Figure 10 – Scenario Properties Menu 

 

By selecting this option, a new scenario properties window will open (Figure 13) 

where the name and description can be changed. 

 

 

Figure 11 – Scenario Properties Window 
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5. Scenario Types 
 

While creating a scenario in Icarus, an scenario type describing the nature of the 

simulation must be selected. This is used by Icarus to better guide the user to an 

easier usage of the interface.  

 

Each scenario type allows/restricts the insertion of different types of objects, and 

determines which types of interaction rules can be added. Besides, it automatically 

configures the magnitudes, constants, and simulation settings that adjust better to 

the type of simulation required.  

 

A brief description of each scenario type and its restrictions are shown below: 

5.1 Gravitation 

 

Allows simulating gravitational interactions between bodies with mass. 

 

Allows inserting: 

- Mass Bodies 

- Gravitational Interaction Rules 

 

Restricts inserting: 

- Charges 

- Galaxies 

- Electric Charges 

- Magnetic Charges 

- Electric Interaction Rules 

- Magnetic Interaction Rules 

 

5.2 Electromagnetism 

 

Allows simulating interactions between charges with other charges, and magnetic 

and electric fields. 

Allows inserting: 

- Charges 

- Electric Charges 

- Magnetic Charges 

- Electric Interaction Rules 
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- Magnetic Interaction Rules 

 

Restricts inserting: 

- Mass Bodies 

- Gravitational Interaction Rules 

- Galaxies 

 

5.3 Galactic Simulations 

 

Allows simulating interactions and collisions between galaxies. 

 

Allows inserting: 

- Galaxies 

- Gravitational Interaction Rules 

 

Restricts inserting: 

- Charges 

- Electric Charges 

- Magnetic Charges 

- Electric Interaction Rules 

- Magnetic Interaction Rules 

- Mass Bodies 

 

5.4 Customized 

 

Allows simulating any types of scenarios without restrictions.Allows inserting: 

- Charges 

- Electric Charges 

- Magnetic Charges 

- Electric Interaction Rules 

- Magnetic Interaction Rules 

- Mass Bodies 

- Galaxies 

- Gravitational Interaction Rules
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6. User Interface 
 

Once the scenario is loaded or created, its configuration and objects are loaded and 

shown in the main interface (Figure 14). Its components and functions are shown as 

following: 

 

 

Figure 12 – Icarus’ Main Interface 

 

6.1 Objects Tab 

 

At the objects tab (Figure 14-1), the user can find and select any of the objects 

created for the scenario. All the new objects to be inserted can be found and selected 

in this tab. The following types of objects can be found in the Objects Tab: 

- Charges 

- Bodies 

- Electric Fields 

- Magnetic Fields 

- Galaxies 
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Each one of the object types will be shown/hidden regarding the Scenario Type. For 

example, if the scenario has Electromagnetism type, no entry for mass objects will 

be found in the Objects Tab.  

 

Upon selecting any element from this tab, you will be able to see and modify the 

objects properties (position, velocity, among others) using the Properties Tab (Figura 

14-4), or directly from the Visualization Window  (Figura 14-3). More details about 

each of these windows can be found later in this chapter.  

 

 

6.2 Scenery Tab 

 

In the Scenery Tab (Figure 14-2 and Figure 15), you can find and select any of the 

auxiliary elements previously inserted. Every auxiliary element on the scenario can 

be found and selected on this tab. The types of elements that can be found in this 

tab are the following: 

- Cameras 

- Props 

- Lights 

- Regions 

 

 

Figure 13 – Scenery Tab 
 

Upon selecting any element from this tab, you will be able to see and modify the 

objects properties (position, velocity, among others) using the Properties Tab (Figura 

14-4), or directly from the Visualization Window  (Figura 14-3). More details about 

each of these windows can be found later in this chapter.  
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It is important that auxiliary elements won’t be visible during the simulation, but will  

during Edit Mode.  

 

 

6.3 Context Menu of Objects/Scenery 

 

All the Scenario objects and props provide a set of actions and options that can be 

used from this context menu that can be activated by right clicking on the object.  

 

 

Context Menu 
 

From the context menu, you can focus camera, approach camera, delete, rename or 

see the properties of the selected object. 

 

6.4 3D Visualization Window 

 

At the 3D Visualization Window (Figure 14-3) you can view the 3D representation of 

the created scenario. You can also see navigate (move the active camera), ans select 

and move objects directly from this window. 

The Visualization Window provides two modes of use, each one with different actions 

that can be performed over them: 

- Edit Mode: Allows selecting and moving objects. 

- Navigation Mode: Allows navigating (moving the active camera) 

through the scenario and change the point of view. 

6.5 Properties Tab 

 

At the Properties Tab (Figure 14-4) you can modify all the attributes from the 

selected object/element. Besides, when an attribute is selected, you can see a 

context help that indicates its meaning.  



Icarus   Version:           1.0 

User Manual   Date:  14/10/2010 

 

http://www.icarus-physics.com/ Universidad Nacional de La Matanza Page 20 de  70 

 

6.6 Icons Bar 

 

En la barra de íconos (Figura 14-5) se encuentran los íconos que permiten 

desarrollar varias acciones al hacerles un clic. A continuación se describe el nombre y 

acción de cada ícono: 

 

Icon Name Action 

 
Create New 

Scenario 
Invokes the New Scenario Window. 

 
Open Scenario Invokes the Open Scenario Window. 

 
Save Scenario Saves the current Scenario 

 
Simulation Mode 

Switches to Simulation Mode. More information 

about this mode can be found later in this Manual. 

 

Simulation Mode 

with Video 

Recording 

Switches to Simulation Mode with Video Recording. 

More information about this mode can be found later 

in this Manual. 

 
Go to X Axis 

Moves the camera towards the closest point of the X 

Axis and points it towards (0,0,0). It is very useful 

to visualize the scenario from different angles 

without moving the camera manually.  

 
Go to Y Axis Same as “Go to X Axis”.  

 
Go to Z Axis Same as “Go to X Axis”. 

 
Point camera 

towards origin 

Points the camera towards the coordinate origin 

(0,0,0). It is useful to recall the camera’s angle. 

 

 

6.7 Menu Bar 

 

At the Menu Bar (Figure 14-6), the user can accede to the rest of the available 

options. All these options are shown as following:  

 

Name Description 

File 
Provides all the actions regarding the creation, 

loading, saving, and properties of the scenario.  

Options 
Provides access to the simulation and video 

configuration windows.  

Tools 
Provides acces to the Interaction Rules Manager, the 

Collision Rules Manager, the Camera Manager, and 

the States Navigator. More information on these 
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manager can be found later in this manual.  

Insert 

Allows inserting new elements/objects to the 

scenario. These elements can be objects, galaxies, 

charges, electric fields, magnetic fields, regions, 

cameras, lights, and props. More information about 

each of these objects can be found later in this 

manual.  

Help 
Contiene opciones de ayuda al usuario e información 

sobre Icarus. 

 

 

6.8 Magnitudes Bar 

 

At the Magnitudes bar (Figure 14-7) all the unit types currently used are displayed. 

These units can be changed from the Simulation Options Window.  
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7. Navigating/Editing the Scenario 
 

Icarus provides the user with an interface that allows navigating and editing the 

scenario using the keyboard and the mouse in a simple and easy to understand 

setting. To make it easier to learn, different actions are divided into two different 

modes: Edit Mode and Navigation Mode.  

 

In Edit Mode, the keyboard and the mouse are used to modify the position, 

inclination, and appearance of the elements of the scenario. In the Navigation mode, 

they are used to move and rotate the active camera. 

 

To switch between both modes, the user must press the Space Bar.  

 

More information about their commands and features are shown as follows. 

 

7.1 Navigation Mode 

 

In Navigation Mode (Figure 16), all commands from the keyboard and the mouse are 

used to move the active camera. Besides, the mouse pointer is hidden to allow a free 

camera movement.  

 

To get back to Edit Mode, the user must press the Space Bar. 

 

Figure 14 – Navigation Mode 
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The following table shows the commands that can be performed during this mode 

and their actions: 

 

Command Action 

Mouse Movement Rotates the camera angle 

Left Click Go Forward 

Right Click Go Backwards 

Key A Go Left 

Key D Go Right 

Key W Go Up 

Key S Go Down 

Key + Increase Camera Speed 

Key - Decrease Camera Speed 

Key F Show FPS 

Space Bar Go to Edit Mode (show mouse pointer) 

 

7.2 Edit Mode 

 

In Edit Mode (Figure 17), all keyboard and mouse commands are used to select and 

edit the elements on the Scenario.  

 

To go back to Navigation Mode, you must press the Space Bar.  

 

 

Figure 18 – Edit Mode 
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The following table shows the commands that can be performed during this mode 

and their actions: 

 

Command Action 

Left Click Select an Object 

Right Click Rotate Camera Angle 

Left + Right Click 
(Over an Object) Pulls/Pushes the object towards/away 

from the camera 

Key F Show FPS 

 

7.2.1 Movement Axes 

 

If the user hold the Shift key after selecting an object, its movement axes will appear 

like it is shown in (Figure 18). 

 

 

Figure 15 – Movement Axes over a Charge 
 

By left-licking and holding the mouse over any of these axes, the user can modify its 

position by moving it in parallel to the axis clicked. By doing this, the user can 

modify the object’s position over an axis without changing the others.  

 

If the same procedure is performed over an electric/magnetic field, you can rotate 

the direction of the field lines.  
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8. Running the Simulation 
 

Once you have finished configuring the scenario, you can start the simulation. When 

the simulation starts, a new window opens (Figure 19) where you can view the 

simulation in real time (guided by the Interaction and Collision rules specified).  

 

In the simulation window, some of the auxiliary elements are hidden, such as: 

- Cameras 

- Lights 

- Regions 

 

 

Figure 16 – Simulation Mode 
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During the simulation, the user can pause and resume it at any moment. The 

visualization will be guided by the settings of the Camera Manager (More information 

about the Camera Manager will be shown later in this manual) The user will only be 

able to move the camera manually if the active camera is configured as manual.  

 

The elapsed simulation time can be seen at the bottom right corner. 

 

There are two different simulation modes: Simulation Mode y Simulation Mode with 

Video Recording. Details about each one are explained as follows: 

8.1 Simulation Mode 

 

The following table shows the keyboard and mouse commands and their actions 

during Simulation Mode: 

 

Command Action 

Key ESC Stop the simulation / close simulation window 

Key P 

Pause/Resume simulation. 

It also generates a new state accessible from the States 

Navigator. 

Key F1 Display commands list. 

Key R Revert simulation to the initial state. 

Key B Reverse Simulation. 

Key PageUp Increase Time Differential  

Key PageDown Decrease Time Differential 

Key V Display Vectors 

Key G 
Enable/Disable simulation visualization. This can be 

useful to quickly advance the simulation.  

Key F Show FPS. 

Key H Displays/Hides the HUD 

Keys X,Y,Z Go to Axis X, Y, y Z respectively. 

Space Bar 

Change between Edit/Navigation Modes 

(Only if the camera is <Manual> and doesn’t point to 

any object) 

 

8.2 Simulation Mode with Video Recording 

 

Simulation Mode with Video Recording allows the user to record the simulation to a 

video file. The recording is set to 1 frame per Simulation step, making sure 24 

frames per second are always reached.  
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By selecting Simulation Mode with Video Recording, a dialog will appear that allows 

selecting the codec to use and the file extension. Once it is selected, the simulation 

window will display. Then, the simulation will run just as in the normal Simulation 

Mode. 

 

Once the simulation ends (the user presses ESC or closes the window, the video file 

is saved and can be opened by the user.  

 

The recording can be used along the Camera Manager to allow following objects 

without imprecise mouse movements.  
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9. Scenario Elements 
 

Here is a detailed description of each element type that can be part of a Scenario.   

 

The attributes of each element can be specified at the moment of insert it (from the 

“Insert” menu from the menu bar), or from the Properties Tab after selecting an 

object.  

 

 

9.1 Mass Bodies 

 

Mass bodies are objects that only interact with gravitational forces. As their name 

indicates it, they possess mass as main attribute, and do not possess charge (they 

are neutral).   

9.1.1 Properties 

 

The properties of these objects are shown as follows: 

  

  

Property Value 

Available in Scenario Types Gravitation, Custom 

Applicable Interaction Rules (Body, Body, Gravitation) 

Applicable Collision Rules 

(Body, Body, Pause) 

(Body, Body, Merge) 

(Body, Region, Pause) 

Can be moved with movement axes Yes 

Can be rotated with movement axes No 

Visible in Simulation Mode Yes 

Can be selected with the Mouse Yes 

Can be selected from the object’s tab Yes 

 

9.1.2 Attributes 

 

A description of its attributes is shown as follows: 

 

Attribute Description 

Position (X Axis) Indicates the X component of the position 

Position (Y Axis) Indicates the Y component of the position 

Position (Z Axis) Indicates the Z component of the position 

Velocity (X Axis) Indicates the X component of the initial velocity 

Velocity (Y Axis) Indicates the Y component of the velocity 

Velocity (Z Axis) Indicates the Z component of the velocity 

Radius 

Indicates the radius of the object. 

All objects with a Radius property are considered spherical in 

the simulation, even though its 3D shape is not spherical. 

Therefore, using a non-spherical shape won’t affect the 
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simulation’s result.  

The radius defined for the object affects the size of its display. 

In an unit scale (scale = 1), the radius is equivalent to its 

representation in the screen.  

The radius is also used to evaluate collision rules.  

Mass Indicates the mass of the object. 

3D Shape 

Indicates the 3D Shape to assign. Any .mesh shape file can be 

used or added to the list of shapes. By default, it is set to 

spherical.  

Texture 

Indicates the object’s texture. Any texture from the list or any 

image files can be used. 

By default, it is set to solid white. 

Scale 

Indicates the visual scale multiplier of the object. It only affects 

the object’s visualization, and does not affect the simulation 

nor its results. Doubling the scale will double the visible size of 

the object. 

By default, it is set to 1. 

 

9.1.3 Inserting a mass body 

 

To insert a mass body, the corresponding option should be selected first from the 

menu bar: 

Insert > Body 

 

By selecting this option, a new insert body window will appear (Figure 20), that will 

allow indicating initial values for all the object’s attributes.  

 

The appearance of the object can be previewed before inserting it in the preview box 

at the right. This preview will refresh when changing the texture or 3D shape.  

 

To change the texture or 3D shape, press the “Change Texture” o “Change 3D 

Shape” buttons, respectively. 
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Figure 17 – Insert Body Window 
 

9.1.4 Modifying a mass body 

 

To modify an already inserted mass body in the scenario, you must first select it. 

There are two ways of selecting such body:  

- Selecting it from the objects’ tab. (Figure 14-1). 

- By clicking on it while in Edit Mode.  

 

Upon selecting the object, its attributes will appear in the properties tab (Figure 14-

4). The user can modify any of its attributes at will.  
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9.2 Charges 

 

Charges are points with no volume that interact with both electric and magnetic 

forces. They have the same attributes as the mass bodies, but also have charge.  

 

9.2.1 Properties 

 

The properties of these objects are shown as follows: 

   

Property Value 

Available in Scenario Types Electromagnetism, Customized 

Applicable Interaction Rules 

(Charge, Charge, Electric) 

(Charge, Electric Field, Electric) 

(Charge, Magnetic Field, Magnetism) 

Applicable Collision Rules (Charge, Region, Pause) 

Can be moved with movement axes Yes 

Can be rotated with movement axes No 

Visible in Simulation Mode Yes 

Can be selected with the Mouse Yes 

Can be selected from the object’s tab Yes 

 

9.2.2 Attributes 

 

A description of its attributes is shown as follows: 

 

Attribute Description 

Position (X Axis) Indicates the X component of the position 

Position (Y Axis) Indicates the Y component of the position 

Position (Z Axis) Indicates the Z component of the position 

Velocity (X Axis) Indicates the X component of the initial velocity 

Velocity (Y Axis) Indicates the Y component of the velocity 

Velocity (Z Axis) Indicates the Z component of the velocity 

Radius 

Indicates the radius of the object. 

All objects with a Radius property are considered spherical in 

the simulation, even though its 3D shape is not spherical. 

Therefore, using a non-spherical shape won’t affect the 

simulation’s result.  

The radius defined for the object affects the size of its display. 

In an unit scale (scale = 1), the radius is equivalent to its 

representation in the screen.  

The radius is also used to evaluate collision rules.  

Mass Indicates the mass of the object. 

3D Shape 

Indicates the 3D Shape to assign. Any .mesh shape file can be 

used or added to the list of shapes. By default, it is set to 

spherical.  

Texture Indicates the object’s texture. Any texture from the list or any 
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image files can be used. 

By default, it is set to solid white. 

Scale 

Indicates the visual scale multiplier of the object. It only affects 

the object’s visualization, and does not affect the simulation 

nor its results. Doubling the scale will double the visible size of 

the object. 

By default, it is set to 1. 

Charge Indicates intensity and sign of the charge. 

 

9.2.3 Inserting a Charge 

 

To insert a Charge, the corresponding option should be selected first from the menu 

bar: 

Insert > Charge 

 

By selecting this option, a new insert body window will appear (Figure 21), that will 

allow indicating initial values for all the object’s attributes.  

 

The appearance of the object can be previewed before inserting it in the preview box 

at the right. This preview will refresh when changing the texture or 3D shape.  

 

To change the texture or 3D shape, press the “Change Texture” o “Change 3D 

Shape” buttons, respectively. 

 

 

Figure 18 – Insert Charge Window 
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9.2.4 Modifying a Charge 

 

To modify an already inserted mass body in the scenario, you must first select it. 

There are two ways of selecting such body:  

- Selecting it from the objects’ tab. (Figure 14-1). 

- By clicking on it while in Edit Mode.  

 

Upon selecting the object, its attributes will appear in the properties tab (Figure 14-

4). The user can modify any of its attributes at will.  

 

9.3 Galaxies 

 

Galaxies in Icarus are formed by a set of non-selectable nodes that represent the 

morphology of a modeled galaxy. These nodes do not have mass nor produce 

interactions, they are only attracted by the nucleus of the galaxis and of other 

galaxies, depending on the Interaction Rules being used. 

The mass of the galaxy is independent from the amount of nodes. The more nodes, 

the better visual model will result, but this won’t affect the final position of the 

galaxy center at the end of the simulation.  

 

The user must choose the amount of nodes that result in both optimal visual quality, 

and optimal performance. Using more nodes, more computational demand is 

required to run each simulation step.  

 

To generate simulations with a high visual quality, the usage of Simulation with 

Video Recording is encouraged. These recordings are independent from the time 

taken for the CPU to simulate each step, and the generated video will display at a 

constant fluid rate.  

9.3.1 Properties 

 

The properties of these objects are shown as follows: 

   

Property Value 

Available in Scenario Types Galactic Simulation, Customized 

Applicable Interaction Rules (Galaxy, Galaxy, Gravity) 

Applicable Collision Rules 
(Galaxy, Galaxy, Pause) 

(Galaxy, Galaxy, Merge) 

Can be moved with movement axes No 

Can be rotated with movement axes No 

Visible in Simulation Mode Yes 

Can be selected with the Mouse Yes 

Can be selected from the object’s tab Yes 

 

9.3.2 Attributes 
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A description of its attributes is shown as follows: 

 

Attribute Description 

Position (X Axis) Indicates the X component of the position 

Position (Y Axis) Indicates the Y component of the position 

Position (Z Axis) Indicates the Z component of the position 

Velocity (X Axis) Indicates the X component of the initial velocity 

Velocity (Y Axis) Indicates the Y component of the velocity 

Velocity (Z Axis) Indicates the Z component of the velocity 

Nucleus Radius 

Indicates the Galaxy’s nucleus radius. The nucleus radius is 

user to group the majority of nodes within the center at the 

moment of its generation. 

The radius of this nucleus does not affect the visualization, as it 

is only used to evaluate collision rules.  

Mass Indicates the mass of the galaxy. 

Color Indicates the color of the galaxy. 

 

9.3.3 Generating a Galaxy 

 

To generate and insert a Galaxy, the corresponding option should be selected first 

from the menu bar: 

Insert > Galaxy 

 

By selecting this option, a new insert galaxy window will appear (Figure 22), that will 

allow indicating initial values for all the galaxy’s attributes. 

 

Icarus’ Galaxy Generator allows the user generating a galaxy from a completely 

customizable configuration. You can start by selecting one of the pre-generated 

examples, or starting a new one from scratch. Each one of the steps and parameters 

for the generation of a new galaxy are shown as follows:  

 

1 - Select Galaxy Type 

The user can choose between three different types of galaxies according to 

the Hubble’s classification: Spiral, Elliptic, and Barred.  

2 - Galaxy Mass 

The mass of the galaxy won’t affect its initial appearance, but will affect the 

radial velocity of its nodes (the more mass, the faster its nodes have to go 

around it), and the intensity of the attraction with other galaxies.  
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Figure 23 – Icarus’ Galaxies Generator 

 

 

3 - Nucleus Radius 

The radius of the galaxy’s nucleus determines several aspects of the galaxy: 

i. During generation, the nucleus radius has more node density than in 

the galaxy arms. This is allows better representing the mass 

distribution that exists in real galaxies, where visible matter is highly 

concentrated in its center.  

ii. During visualization, the radius has no effects whatsoever. The internal 

radius is not visible by itself, but betrayed by the higher density of 

nodes.  

iii. En the evaluation of Collision Rules, the collision occurs if the distance 

from each galaxy centers is less than the sum of their radii.  

 

4 - External Radius 

The external radius is only relevant at the time of generating the galaxy, and 

only determines the distance from the center of the galaxy to the farthest 

node. This also determines the apparent size of the galaxy.  

 

The higher the external radius, the less density of nodes. Therefore, if you 

wish to maintain the nodes density while extending the galaxy size, you 

should add more nodes. 
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5 - Node Count 

Indicates the amount of nodes that will form the galaxy. With more nodes, a 

better visual representation will be obtained.   

 

However, adding more nodes will affect the performance of the simulation. 

6 - Maturity 

Indicates the simulation steps that will be ran exclusively over the generated 

galaxy before inserting it into the scenario. This is necessary to give the 

galaxy’s characteristic shape that cannot be obtained in one-step.  

 

Galaxies generated with more maturity will look more real, compared to those 

non-matured. However, maturing a galaxy will take some processing time.  

 

7 - Arms Count 

(Only for Spiral and Barred galaxies) 

Indicates the amount of arms that the galaxy will have. Each arm will 

consume additional nodes, so the amount of nodes should be also increased.  

 

8 - Elliptic Factor 

(Only for Elliptic Galaxies) Es el factor que determina la forma de las galaxias 

elípticos. Definido por Hubble, es un número real de 0 a 7 donde 0 es una 

forma perfectamente esférica, y 7 representa una galaxia casi plana. 

 

9 - Edges Count 

(Only for Elliptic Galaxies) Determines inversely the separation between the 

edges of the elliptic galaxy. The more edges, the more uniform will the galaxy 

result. Adding more edges may require adding more nodes to maintain the 

nodes density.  

 

10 - Generate and Preview Galaxy 

Once all the factors are configured, the user may press the “Generate” 

button. By doing this, the new galaxy is generated and matured (this may 

take some minutes). Once this process finishes, the new galaxy can be 

previewed in the box at the right. If the result was not satisfactory, the user 

can change one of its attributes and generate it again, without inserting the 

intermediate results into the scenario.  

11 - Defining Color and Angle. 

After generating a galaxy, the user may define its color and insertion angle. 

The color can be chosen from the menu at the bottom.  

 

The angle can be manually defined, or automatically defined by the galaxy’s 

speed. If it is defined as a function of the speed, the galaxy will have a 

parallel inclination to its velocity. 

 

12 - Insert Galaxy 

To insert a galaxy into the scenario, it only takes to click the “Add” button. 
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9.3.4 Modifying a Galaxy 

 

Icarus does not allow the modification of the galaxy’s attributes once it is inserted 

yet.  

 

9.4 Fields (Electric/Magnetic) 

 

Fields in Icarus have visual representations that allow the user view the, select the, 

and have a notion of its direction and limits.  

 

Upon selecting a field, you can visualize the flow of arrows that indicate its direction 

and sign. These also remain visible during the simulation.  

 

You can define bounds for each field (For example, those separated by a Faraday 

cage). The bounds are visible in the sense that no arrows will be displayed outside 

these limits. These limits are only defined by a region aligned to the normalized axis 

(No angles limits can be defined).  

 

The bounds of the field define a spatial region within which the field interacts with 

charges (as long as Interaction Rules are set). Outside these limits, no interaction 

with the field is calculated.  

 

The fields are defined by its nature (Electric or Magnetic), and its shape (Superficial, 

Lineal, or Uniform). The possible combinations are illustrated in the following table: 

 

 Electric Magnetic 

Superficial Si No 

Uniform Si Si 

Lineal Si Si (Inducted by Current) 

 

9.4.1 Properties 

 

The properties of these objects are shown as follows: 

   

Property Value 

Available in Scenario Types Electromagnetism, Customized 

Applicable Interaction Rules 
 (Charge, Electric Field, Electric) 

(Charge, Magnetic Field, Magnetism) 

Applicable Collision Rules - 

Can be moved with movement axes 

Yes (Lineal) 

Si (Superficial) 

No (Uniform) 

Can be rotated with movement axes Si (Todos) 

Visible in Simulation Mode Yes 

Can be selected with the Mouse Yes 
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Can be selected from the object’s tab Yes 

 

9.4.2 Attributes 

 

A description of its attributes is shown as follows: 

 

Attribute Description 

Position (X Axis) 
Indicates the component X of the position of the reference 

point of the field in space (only for lineal and superficial) 

Position (Y Axis) 
Indicates the component Y of the position of the reference 

point of the field in space (only for lineal and superficial) 

Position (Z Axis) 
Indicates the component Z of the position of the reference 

point of the field in space (only for lineal and superficial) 

Direction  

(X Axis) 

Indicates the component X of the field’s direction (in lineal 

fields, it only indicates the direction of the electric current) 

Direction  

(Y Axis) 

Indicates the component Y of the field’s direction (in lineal 

fields, it only indicates the direction of the electric current) 

Direction  

(Z Axis) 

Indicates the component Z of the field’s direction (in lineal 

fields, it only indicates the direction of the electric current) 

Lower Bound (X 

Axis) 
Indicates the component X of the Field’s Lower Bound  

Lower Bound (Y 

Axis) 
Indicates the component Y of the Field’s Lower Bound 

Lower Bound (Z 

Axis) 
Indicates the component Z of the Field’s Lower Bound 

Upper Bound 

 (X Axis) 
Indicates the component X of the Field’s Upper Bound  

Upper Bound 

 (Y Axis) 
Indicates the component Y of the Field’s Upper Bound 

Upper Bound 

 (Z Axis) 
Indicates the component Z of the Field’s Upper Bound 

Intensity 

Indicates the intensify of the field. 

Each one of the 5 possible combinations of Nature/Shape has a 

different magnitude unit for this attribute. More information on 

each magnitude can be found later in this manual.  

The more absolute value, the stronger force will be produced 

on each charge affected by it. 

Color 
Indicates the representation color of the field. By default it will 

be set as light blue.  

Scale 

Indicates the visual scale multiplier of the object. It only affects 

the object’s visualization, and does not affect the simulation 

nor its results. Doubling the scale will double the visible size of 

the object. 

By default, it is set to 1. 

 

9.4.3 Inserting a Field 

 

To insert a field, the corresponding option should be selected first from the menu 

bar: 
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Insert > Field > Electric > Lineal 

Insert > Field > Electric > Superficial 

Insert > Field > Electric > Uniform 

Insert > Field > Magnetic > Lineal 

Insert > Field > Magnetic > Uniform 

 

By selecting one of these options, a field by default will be added. 

 

9.4.4 Modifying a field 

 

Once the field was added, you can modify it only after selecting it. You can select a 

field by either: 

- Selecting it from the object’s tab (Figure 14-1). 

- By clicking it during Edit Mode (except uniform fields) 

 

Upon selecting it, all its attributes will appear in the properties tab (Figure 14-4). 
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10. Scenery 
 

In this chapter you can find a detailed description of the functions and properties of 

every scenery element that support the visualization of the simulation (like cameras, 

lights, and props) and those that affect the simulation (regions).  

 

The attributes of a scenery element can be specified at the moment of inserting it 

(from the “insert” menu item), or from the properties tab after selecting them.  

 

Except for props, none of these elements are visible during the simulation in the 

scenario.  

 

 

10.1 Cameras 

 

Cameras in Icarus are the elements that define the position an angle from which the 

simulation is going to be seen during the simulation. Several cameras can be created 

and the user can define intervals for each one to be activated (See Camera Manager, 

later in this manual).  

 

At every moment, only one camera can remain active. (Which is the point from 

which the simulation will be seen)  

 

 

Figure 19  - Camera 
 

10.1.1 Setting the active Camera 

 

- During Edit Mode 
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In order to use a camera (use it as viewpoint), you must select the “Use this 

camera” option (Figure 24) from the context menu by right-clicking over the scenery 

tab.  

 

 

Figure 20 – Setting the active camera. 
 

- During Simulation Mode. 

 

The order and duration of each camera activation during Simulation Mode is 

determined by what was configured by the Camera Manager. 
 

10.1.2 Properties 

 

The properties of these objects are shown as follows: 

   

Property Value 

Available in Scenario Types Todos 

Applicable Interaction Rules N/A 

Applicable Collision Rules N/A 

Can be moved with movement axes Yes 

Can be rotated with movement axes No 

Visible in Simulation Mode No 

Can be selected with the Mouse Yes 

Can be selected from the object’s tab Yes 
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10.1.3 Attributes 

 

A description of its attributes is shown as follows: 

 

Attribute Description 

Position (X Axis) Indicates the X component of the position 

Position (Y Axis) Indicates the Y component of the position 

Position (Z Axis) Indicates the Z component of the position 

Time Lapse 

Indicates the time that the camera will remain active during 

Simulation Mode. The order in which each camera will be 

activated depends on what is configured in the Camera 

Manager. 

Indicate -1 for infinite time. 

 

Point to 

Indicates to which body/charge/galaxy the camera will 

constantly follow. If you select an object, the camera  will 

follow and focus it, and cannot be manually moved.  

Indicate <Manual> to allow for a free camera movement (it 

won’t follow any object)  

 

  

10.1.4 Inserting a Camera 

 

To insert a Camera, the corresponding option should be selected first from the menu 

bar: 

Insert > Scenery > Camera 

 

By selecting one of these options, a camera by default will be added. 

 

10.1.5 Modifying a Camera 

 

Once the camera was added, you can modify it only after selecting it. You can select 

a field by either: 

- Selecting it from the Scenery tab (Figure 14-1). 

- By clicking it during Edit Mode. 

 

Upon selecting it, all its attributes will appear in the properties tab (Figure 14-4). 
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10.2 Light Sources 

 

Light sources (lights) are elements that allow the user create an adequate light 

settings for the scenario. It is possible to define its intensity, its attenuation and its 

color.  

 

By default, all scenarios are created with an ambient light, but this can be deleted or 

changed at will. 

 

 

Figure 21 – Light Source 
 

 

10.2.1 Properties 

 

The properties of these objects are shown as follows: 

   

Property Value 

Available in Scenario Types All 

Applicable Interaction Rules N/A 

Applicable Collision Rules N/A 

Can be moved with movement axes Yes 

Can be rotated with movement axes No 

Visible in Simulation Mode No 

Can be selected with the Mouse Yes 

Can be selected from the object’s tab Yes 
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10.2.2 Attributes 

 

A description of its attributes is shown as follows: 

 

Attribute Description 

Position (X Axis) Indicates the X component of the position 

Position (Y Axis) Indicates the Y component of the position 

Position (Z Axis) Indicates the Z component of the position 

Intensity Indicates the light’s intensity. 

Range Indicates the light’s maximum reach distance  

Attenuation 

Constant – Indicates how the light intensity diminishes in every 

position.  

Lineal – Indicates how it diminishes linearly with the distance. 

Quadratic – Indicates how it diminishes as the square of the 

distance. 

Color Indicates the color of the light generated by the light source. 

Activate Indica if the selected light is the active light. 

  

10.2.3 Inserting a Light Source 

 

To insert a light, the corresponding option should be selected first from the menu 

bar: 

Insert > Scenery > Light 

 

By selecting one of these options, a light by default will be added. 

 

10.2.4 Modifying a Light 

 

Once the light source was added, you can modify it only after selecting it. You can 

select a field by either: 

- Selecting it from the Scenery tab (Figure 14-1). 

- By clicking it during Edit Mode. 

 

Upon selecting it, all its attributes will appear in the properties tab (Figure 14-4). 
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10.3 Prop (Decorative Object) 

 

Props are elements that can be inserted into the scenario only for visual purposes. 

They do not affect the simulation or the interface. They are not selectable from Edit 

Move, and do not impede the selection of other objects.  

 

They are useful to represent objects that won’t interact with the simulation, but 

serve as a visual aid to understand the simulated problem.  

 

 

Figure 22 – Prop example: a Faraday cage 

 

10.3.1 Properties 

 

The properties of these objects are shown as follows: 

   

Property Value 

Available in Scenario Types Todos 

Applicable Interaction Rules N/A 

Applicable Collision Rules N/A 

Can be moved with movement axes Yes 

Can be rotated with movement axes No 

Visible in Simulation Mode Yes 

Can be selected with the Mouse No 

Can be selected from the object’s tab Yes 
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10.3.2 Attributes 

 

A description of its attributes is shown as follows: 

 

Attribute Description 

Position (X Axis) Indicates the X component of the object’s position 

Position (Y Axis) Indicates the Y component of the object’s position 

Position (Z Axis) Indicates the Z component of the object’s position 

Size Allows increasing/decreasing the size of the object 

3D Shape 

Indicates the 3D Shape to assign. Any .mesh shape file can be 

used or added to the list of shapes 

By default, it is set to spherical.  

Texture 

Indicates the object’s texture. Any texture from the list or any 

image files can be used. 

By default, it is set to solid white. 

Scale 

Indicates the visual scale multiplier of the object. It only affects 

the object’s visualization, and does not affect the simulation 

nor its results. Doubling the scale will double the visible size of 

the object. 

By default, it is set to 1. 

  

10.3.3 Inserting a Prop 

 

To insert a Prop, the corresponding option should be selected first from the menu 

bar: 

Insert > Scenery > Prop 

 

By selecting this option, a new insert body window will appear (Figure 27) that will 

allow indicating initial values for all the object’s attributes.  

 

The appearance of the object can be previewed before inserting it in the preview box 

at the right. This preview will refresh when changing the texture or 3D shape.  

 

To change the texture or 3D shape, press the “Change Texture” o “Change 3D 

Shape” buttons, respectively. 
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Figure 23 – Insert Prop Window 

 

 

10.3.4 Modifying a Prop 

 

Once the light source was added, you can modify it only after selecting it. You can 

select a field by either: 

- Selecting it from the Scenery tab (Figure 14-2). 

- By clicking it during Edit Mode. 

 

Upon selecting it, all its attributes will appear in the properties tab (Figure 14-4). 
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10.4 Regions 

 

Regions in Icarus are imaginary boxes defined by Upper and Lower XYZ bounds and 

aligned to the axes, that allow determining, at any moment of the simulation, if an 

object is inside/outside it.  

 

Regions can only be used to define collision rules. These rules allow pausing the 

simulation when an object collides with any of these regions.  

 

For example, we can define regions to represent the shape of an already inserted 

prop prop such as the Faraday Cage (Figura 26), we can stop the simulation as soon 

as any charge collides with the cage walls.  

 

 

 
Figure 24 – A Region in Icarus 

 

 

10.4.1 Properties 

 

The properties of these objects are shown as follows: 
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Property Value 

Available in Scenario Types Todos 

Applicable Interaction Rules N/A 

Applicable Collision Rules 

(Body, Region, Pause) 

(Charge, Region, Pause) 

(Galaxy, Region, Pause) 

Can be moved with movement axes Yes 

Can be rotated with movement axes No 

Visible in Simulation Mode No 

Can be selected with the Mouse No 

Can be selected from the object’s tab Yes 

 

10.4.2 Attributes 

 

A description of its attributes is shown as follows: 

 

Attribute Description 

Lower Bound (X 

Axis) 
Indicates the component X of the Field’s Lower Bound  

Lower Bound (Y 

Axis) 
Indicates the component Y of the Field’s Lower Bound 

Lower Bound (Z 

Axis) 
Indicates the component Z of the Field’s Lower Bound 

Upper Bound 

 (X Axis) 
Indicates the component X of the Field’s Upper Bound  

Upper Bound 

 (Y Axis) 
Indicates the component Y of the Field’s Upper Bound 

Upper Bound 

 (Z Axis) 
Indicates the component Z of the Field’s Upper Bound 

  

10.4.3 Insertando una región 

 

To insert a region, the corresponding option should be selected first from the menu 

bar: 

Insert > Scenery > Region 

 

By selecting this option, a new insert body window will appear (Figure 29) that will 

allow indicating initial values for all the region’s attributes.  
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Figure 25 – Insert Region Window 

 

 

10.4.4 Modifying a region 

 

Once the region was added, you can modify it only after selecting it. You can select a 

field by either: 

- Selecting it from the Scenery tab (Figure 14-2). 

 

Upon selecting it, all its attributes will appear in the properties tab (Figure 14-4). 
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11. Simulation Rules 
 

Simulation Rules in Icarus define the forces to be evaluated between the objects and fields 

of the scenario. There are two types of simulation rules: 

- Interaction Rules 

- Collision Rules 

 

Both types are defined as follows: 

 

11.1 Interaction Rules 

 

Interaction rules define which elements will interact between each other during the 

simulation. They also define what kind of interaction will these elements exchange. 

 

The list of rules is evaluated for each simulation step. Therefore, the more rules to be 

evaluated, the more computing time will each step demand.  

 

More information about how these rules work can be found in the document Icarus Physics 

Engine Manual.  

 

To review the interaction rules list, or add/remove a rule, you must first open the 

Interactions Manager Window (Figure 30) by selecting the following option from the Icarus’ 

Menu.  
 

Tools > Interactions Manager 

 

 

Figure 26 – Interactions Manager 
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11.1.1 List of Rules 

 

In the list of rules you can see which interaction rules have already been inserted.  

 

Rules in Icarus have the format: 

 

(Object, Influenced by, Interaction Type) 

 

-   Object: Is the one that is influenced by the attraction/repulsion force of the 

interaction. 

-   Influenced by: Is the object that will provoke the force over the influenced object. 

Since rules are not reciprocal, this object will not suffer a contrary force. 

-   Interaction Type: It determines the nature of the interaction that is being 

evaluated. It can be gravitational, electric, or magnetic. 

 

Since rules are not reciprocal, it is necessary to insert two different and opposed rules for 

two objects to interact completely. (See Figures 31 y 32) 

 
 

 
Figure 27 – Unilateral Rule 

 
Figure 28 – Reciprocal Rule 

 

11.1.2 Add Rule 

 

To add a new rule, you must first select the interaction type. The list of possible interaction 

types depend on the scenario type.  

 

Once you select the interaction type, the Interactions Manager will show a list of possible 

interacting objects.  

 

Once the three component of a rule are selected, you can press the “Add” button and add 

the new rule to the list.  

 

It is not possible to add repeated rules.  

 

11.1.3 Delete Rule 

 

To delete a rule, you must first select it from the list by clicking on it. Them you must press 

the “Delete” key. If you wish to clean the whole list, you can press the “Clean List” button.  
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11.2 Collision Rules 

 

Collision Rules in Icarus allow defining an action in case two objects (or an object and a 

region) contact each other.  

 

The list of rules is evaluated for each simulation step. Therefore, the more rules to be 

evaluated, the more computing time will each step demand.  

 

To review the collision rules list, or add/remove a rule, you must first open the Collisions 

Manager Window (Figure 33) by selecting the following option from the Icarus’ Menu.  
 

Tools > Collisions Manager 

 

 
Figure 29 – Collisions Manager 

 

11.2.1 Rules List 

 

In the list of rules you can see which collision rules have already been inserted.  

 

Collision rules in Icarus have the format: 

 

(Object 1, Object 2, Action) 

 

-   Object 1: One of the objects to evaluate. 

-   Object 2: The other object/region to evaluate. 

-   Action: The type of action that will be automatically performed as soon as the two 

objects contact each other.  

 

Collision rules are reciprocals, and only one rule should be added to evaluate a collision 

between two objects.  
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11.2.2 Actions 

 

There are two diferent types of action that can be performed as soon as the two 

objects/region contact: 

 

- Merge objects: (Only for gravitational scenarios) The two objects are merged, 

using a center-of-mass method to sum their masses, radiuses, velocities, and 

positions.  

 

-   Pause Simulation: The simulation is automatically paused, letting the user 

resume it by pression the “P” Key.  
 

11.2.3 Add Rule 

 

To add a new rule, you must first select the interaction type. The list of possible interaction 

types depend on the scenario type.  

 

Once you select the interaction type, the Collisions Manager will show a list of possible 

interacting objects.  

 

Once the three component of a rule are selected, you can press the “Add” button and add 

the new rule to the list.  

 

It is not possible to add repeated rules.  

 

11.2.4 Delete Rule 

 

To delete a rule, you must first select it from the list by clicking on it. Them you must press 

the “Delete” key. If you wish to clean the whole list, you can press the “Clean List” button.  
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12. Simulation Options 
 

Icarus allows the user changing almost every variable used to configure the simulation. This 

configuration includes the constants, magnitudes, numerical representaion, and 

performance settings.  

 

In order to configure the simulation options you must first open the Simulation Options  

window (Figure 34) by selecting the next option from the Icarus’ menu: 
 

Options > Simulation Options 

 

 

Figure 30 – Simulation Options Window 
 

The Simulation Options window counts with 4 selectable tabs. Each tab’s settings are shown 

as follows:  

 

12.1 Constants 

 

Constants in Icarus are those values that are used by the Icarus Physics Engine to calculate 

the forces at every simulation step, and that do not depend from the scenario’s 

configuration.  

 

Every scenario can have a different set of simulation constants that are configured by the 

user and are kept when the scenario is saved.  
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The following list describes each constant and their meaning: 

 

 Time Differential: Indicates the time lapse between different discrete steps of the 

simulation. The smaller the lapse, the more precise will be the simulation, while 

bigger lapses will allow a faster simulation. Therefore, a balance between 

performance and speed should be obtained with this value. A negative differential can 

be used for backward simulation. More Information: Icarus Physics Engine Manual. 

 

 Gravitational Constant (G): Allows setting the Universal Gravitational Constant. By 

default, this value is set to the real G value. However, it can be modified to any other 

value. More Information: Icarus Physics Engine Manual. 

 

 Coulomb’s Constant: Allows setting the Coulomb constant. By default, this value is 

set to the real k value. However, it can be modified to any other value. More 

Information: Icarus Physics Engine Manual. 

 

 Total Simulation Time: Indicates the total simulation time lapse. When the elapsed 

time reaches this value, the simulation will stop. This is especially useful for recorded 

simulations.\n\n Insert 0 for infinite time. 

 

 

12.2 Magnitudes 

 

Magnitudes define the unit types to be used in the scenario.  

In order to allow different types of scenarios with different time differentials, charge, and 

mass units, Icarus allows configuring each one of these units using multiples of 

Meter/Gram/Second/Coulomb. 

 

 

Figure 31 – Magnitudes Tab 
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The magnitudes in use only affect the representation of numbers. When the user changes a 

unit type, all numeric attributes in the scenario that relate to that type are converted to 

preserve their relation. As a result, a change in a unit type will not affect the result of a 

simulation.  

 

The unit types currently used can be visualized in the bottom bar of the main interface. 

(Figure 14-7) 

 

 

12.3 Numerical Representation 

 

Icarus allows defining how the numbers are represented in the interface and the 

visualization window. The numerical representation does not affect the simulation results 

nor the data involved.  

 

 

 

Figure 32 – Numerical Representation Tab 

 

The following list describes representation mode and and their meaning: 

 

- Scientific Notation: 

 Indicates that the scientific numerical display will be used. 

              Syntax: [Mantissa]e[Exponent] 

              Example: 1.23e-10-  

- Extensive Notation: 

 Indicates that the extensive numerical display will be used. 

Syntax: [Number] 

Example: 1.00025 
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- Decimals to Display: 

Allows limiting the amount of decimals after the comma to be shown. 

Important: This will not affect the simulation precision, as it only limits its 

representation on the screen. 

Example: taking the number 0.123456789 shown in Extensive Notation (and 

Scientific Notation)  

With 2 decimals to display: 0.12 (1.2e-1) 

With 5 decimals to display: 0.12345 (1.2345e-1) 

With 9 decimals to display: 0.123456789 (1.23456789e-1) 

With 12 decimals to display: 0.123456789 (1.23456789e-1) 

 

 

12.4 Performance 

 

Icarus allows configuring its performance options that could optimize the speed and 

efficiency of its simulation engine.  

 

The efficiency of these options depends on the hardware capabilities and on each scenario 

configuration.  

 

 

 

Figure 33 – Performance Tab 
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A description and examples of each performance setting are shown as follows: 

12.4.1 Multithreading level (Thread count) 

 

Indicates the amount of processing threads that will be used during the simulation. 

Select the number that better adjusts to the amount of cores your processor has to obtain 

the best performance 

12.4.2 Numerical Resolution Algorithm 

 

Indicates the finite differential numeric resolution algorithm to use. 

The functioning of each algorithm is explained in the Icarus Physics Engine Manual. 
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13. Display Options 
 

Icarus allows the user configuring the way that the Interface and Simulation screens will 

look. Besides, it allows activating auxiliary elements in the simulation such as force vectors 

and traces that add educational information to the basic visualization.  
 

In order to configure the simulation options you must first open the Display Options  

window (Figure 38) by selecting the next option from the Icarus’ menu: 

 

Options > Display Options 

 

 

 

Figure 34 – Display Options 
 

The Simulation Options window counts with 4 selectable tabs. Each tab’s settings are shown 

as follows:  

13.1 Video Settings 

 

The video settings allow configuring the video output options on Icarus. 

 

Each settings in this tab are described as follows: 

13.1.1 Full Screen 

 

Allows displaying the simulation window in full screen, once the simulation is started. 
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13.1.2 Video Resolution 

 

Allows defining the video resolution during the simulation 

 

13.1.3 Refresh Rate 

 

Allows defining the refresh rate for the edition and simulation modes. It won't affect the 

recorded simulation mode. 

 

13.1.4 Max Visualization Distance 

 

Indicates the maximum visualization distance of an object regarding the active camera. The 

objects situated further from this value won't be visualized. 

13.1.5 PostProcessing Options 

 

Allows activating video postproduction effects. Enable/Disable these effects at will. 

 

13.2 Vectores 

 

Vectors are elements that allow showing force intensity lines for each object in the 

simulation. It has an educational value as it allows knowing the amount of force being 

exercised over every object/charge.  

 

Figure 35 – Vectors Tab 

 

In the visualization, the vector is shown as a colored line that starts in the object and points 

towards the direction of the force, and has a length equivalent to the intensity of the force.  

 

In Figure 40, you can see an example of a force over a charge where the total magnetic 

force is represented in purple, and the total electric force is shown in cyan.   

 



Icarus   Version:           1.0 

User Manual   Date:  14/10/2010 

 

http://www.icarus-physics.com/ Universidad Nacional de La Matanza Page 62 de  70 

 

 

Figure 36 – Vectors use example 

 

 

In the vectors tab (Figure 39), the user can select which forces/velocities will be 

represented by activating the corresponding check boxes. You could also define a scale that 

will increase its size linearly and a different color for each one. 
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13.3 Scenario Tab 

 

In the Scenario Tab (Figura 41) you can configure the options that affect the visualization of 

the space and elements of the scenario.   

 

 

Figure 37 – Scenario Tab 
 

 

Each settings in this tab are described as follows: 

 

13.3.1 Visual Scale 

 

Allows setting the visualization scale for the size of objects in the screen. It is useful to 

augment the apparent size of object that are too far away from each other. This does not 

affect the simulation results. 

13.3.2 Ambient Color 

 

Allows defining the scenario's ambient color. By default, it is set to white. 

13.3.3 Background Image 

 

It allows specifying a background image for the scenario. It will be visualized in the shape of 

a Skybox. 

 

13.3.4 Background Color 

 

Allows defining the ambient color for the scenario, in case that no background image is 

selected. 

13.3.5 Camera Speed 

 

Defines the camera's movement speed. It is expressed in units of distance per movement 
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action. 

 

13.3.6 Axes Size 

 

Allows defining the size of the Cartesian axes. Indicate 0 to disable them. 

 

 

13.4 Traces 

 

In the Traces Tab (Figura 42) you can configure the options that affect the objects trail 

visualization when they move through the simulation space.  

 

 
Figure 38 – Traces Tabs 

 

In order to visualize the traces from the objects trails, you must first enable traces in the 

check box within this tab.  

 

Then, you must select which objects are to leave a trace by selecting such objects and 

activate their traces as shown in (Figure 43). 
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Figure 39 – Enabling an object’s trace 

 

By doing this, you can decide which objects will leave a trace and which will not. You can 

also define a different color for each one.   

 

In Figure 44, an example is shown of a charge’s trace while trapped in a magnetic field 

during a simulation. 

 

 
Figure 40 – Traces use example 
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The options included in the traces tab are described as follows: 

 

13.4.1 Enable Traces 

 

Allows enabling the visualization of moving objects traces during the simulation. Once 

enabled, they must be configured for each object individually and a color must be selected 

for each object. (Click on any object to enable this option) 

 

13.4.2 Line Thickness 

 

Allows defining the object's trace line thickness. 

 

13.4.3 Max Length 

 

Defines the length of the object's trace.\n\n Once the max value is reached, it starts erasing 

from the beginning. 
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14. States Navigator 
 

In Icarus, after running and stopping a scenario, it comes back to the initial state from 

which it started. However, the user may want to continue editing it from an intermediate or 

final state.  

 

To achieve this, Icarus has a State Navigator (Figure 45). It allows working on the initial, 

intermediate, and final states. These are named based on the time on which they were 

saved.  

 

 

 
Figure 41 – States Navigator 

 

 

The initial and final states are always saved automatically. The intermediate states are 

saved every time the user presses the pause (P) key.  

 

14.1 States Generation 

 

The following figure shows how the states are generated and placed in the states list. 
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In order to go to another state, you must open the States Navigator window selecting this 

option on the Icarus’ Menu.  
 

Tools > States Navigator 

 

14.2 Go to State 

 

The states navigator allows taking back/advance a simulation to its initial/final states of an 

already ran simulation. It also allows saving intermediate states by pressing 'p' during the 

simulation. Each state is expressed in time units from the beginning of the simulation. Once 

selected, press 'Go to State' to load it. 

Start Pause 1 Pause 2 End 

T0 = 0 T1 T2 Tf 

Time Elapsed from the beginning of the simulation 

T1 

T2 

Tf 

T0 

    States List 
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15. Camera Manager 
 

Icarus allows two camera management modes: 

 

 Manual Mode: The angle and position of the camera is changed manually 

using the mouse and keyboard during the whole simulation.  

 

 Director Mode: The angle and position of the cameras are changed 

automatically during the simulation. You can define more than one camera, 

and the order in which they will be used.  

 

In order to set the way in which the cameras will be used during the simulation, you must 

open the Camera Manager window (Figure 46) selecting this option on the Icarus’ Menu.  

 

Tools > Cameras Manager 
 

 

 
Figure 42 – Cameras Manager 

 

In the Cameras manager window, the filming order is shown, starting from the first camera 

to use (on top) and indicating the total activity time that it will use.  

 

The cameras order can be changed the “Up” and “Down” buttons. The activity time can be 

changed by changed its value and then pressing the “Modify” button. In order to specify an 

infinite time, indicate “-1”.  

 

Each camera management mode is shown as follows: 
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15.1 Manual Mode 

 

The manual mode is defined by default when creating a new scenario.  

 

In order to configure the manual mode, you must define a unique camera with infinite time. 

Figure 47  shows how to configure a manual camera.  

 

 
Figure 43 – Manual Mode Configuration 

 

 

15.2 Director Mode 

 

The director mode is especially useful for video recorded simulations because, based on the 

way that simulations are run, using the manual camera can result in undesirable 

movements.  

 

To make use of the Director Mode, you must define more than one camera (pointing to a 

fixed place or following an object). Then, you must define their order and activity time for 

each one. Figure 46 shows an example of a director mode of camera usage.  


